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KOZJA STAZA KROZ VIDEO BESPU A 
 
Žeilte samo kona no na novom TV-u od  sedam tisu a s ekranom od 115 cm odgledati najdraži 
video koji je do sada na neuglednom ra unalnom ekran u od 17 cola Vaš ra unalni player 
bezbroj puta besprijekorno odvrtio. Me utim, kipte i od bijesa, konstatirate da Vaš novi video-
player samo škrgu e, umjesto da u punoj raskoši velikog formata prikaže taj isti DVD, koji u 
ra unalu radi bez greške. 
 
Nema druge, mora se pogledati u upute uz player. Ali avaj, tamo sve vrvi od nekih klingonskih 
rije i kao NTSC, video-bitrate, WMVHD, VCD, MP2, AC3, WMA, QDESIGN, MPEG2, H.264/AVC, 
.SUP datoteke, video filtri, File Splitting, SubRip i tome sli no. Do e Vam na isto gledate li u 
korejske ili hrvatske upute.  
 
Odustanak, ili edukacija, pitanje je sad ?! Ako Vam i rije i piksel, rezolucija, HDTV, DVBT zvu e  
klingonski, možda bi bilo dobro da u internetsku tražilicu ukucate :    
 

http://hr.wiktionary.org/wiki/Suradnik:Bela 
 

Na i ete se u internet-slobodnoj enciklopediji – wikipediji, odnosno u njenom sestrinskom 
projektu – wiki-rje niku  (radnog naziva wje nik).  Na navedenoj web-adresi na i e se izme u 
ostaloga i dio osnovnih pojmova iz podru ja AV (audio-vizualne) tehnike, a ega nema tamo, 
pokušajte na i (tj. utipkati rije  u wiki-tražilicu) na wikipediji ili na ostalim suradni kim 
stranicama wiki-rje nika. Mnogi suradnici-volonteri vrijedno rade na obradi novih pojmova, pa 
na e se i onih koji obra uju tehniku. A što je izuzetno važno, na Wikipediji su zabranjeni 
komercijalni sadržaji, dakle, (zamislite !), nitko Vam ništa ne e nuditi ni prodavati, nego samo 
(manje ili više dobro) objasniti pojam koji Vas je zanimao i to potpuno besplatno i bez 
beskrajnog pretraživanja po svakakvom sme u. 
Za one koji nisu totalne AV-neznalice, evo kozje pre ice kroz video bespu a u obliku sažetog 
"prosvjetljenja". 
 
VIDEO FORMATI 
 
Nekomprimirani video, najsli niji je celuloidnom filmu. 25 samostalnih sli ica (frame-ova), u 
sekundi, sastavljenih od razli ito obojenih i osvijetljenih to kica (piksel-a) na monitoru, (takva 
vrsta slika zove se Bitmap-a) nižu se jedna za drugom stvaraju i iluziju pokretne slike. Tome 
je dodana i zvu na komponenta, koja je "upakirana" u nekom od mnogih audio-formata. 
Datoteka koja sadrži tako spremljen audio-video sadržaj, ima nastavak .AVI i uobi ajeni je 
rezultat snimanja digitalnom video-kamerom, posebno ako je rije  o kameri koja snima na 
mini-DV magnetnu traku. Takav video zauzima me utim vrlo velik memorijski prostor, pa se 
zbog uštede diskovnog prostora redovito "komprimira", tj. pretvara (ispravnije je re i 
prekodira) u skup informacija koje su dostatne za uredno odvijanje reprodukcije, uz primjenu 
trikova kojima se smanjuje diskovno zauze e. 
 
Takva, komprimirana video-datoteka ima samo po etnu kompletnu sli icu (tzv. keyframe) , 
dok slijede e krnje "sli ice" (P-frame) sadržavaju samo izmjene u odnosu na prethodnu, dakle 
uop e i nisu slike. Po etna slika uklju uje i druge informacije od zna aja za reprodukciju, ali i 
informacije o korištenom programu za komprimiranje (tzv. Kodek – engl: codec) slike i 
posebno zvuka.  itav video sadrži mnoštvo key-frame-ova me u kojima su umetnuti P-
frameovi. 
 
Kao što to obi no biva, istovremenim razvijanjem tehnologija, nastao je itav niz razli itih 
standarda i programa za komprimiranje (kodeka), što nas po obi aju  vodi do problema 
me usobne kompatibilnosti video snimaka i opreme za snimanje i reprodukciju. Ipak, razni 
na ini kodiranja, prikladni su za razli ite namjene.  Da puno ne dužimo, tabelarno su prikazane 
naj eš e vrste medija (opti kih ili magnetskih nosa a informacija – diskova i traka), me u koje 
svrstavamo i ra unalni vrsti disk. U novije vrijeme narasli su i kapaciteti "džepnih" pamtila 
(memory-stick – memorijski štapi i, mobiteli, i-pod), pa se video sekvence mogu gledati i na 
ure ajima džepnog formata, no ta kategorija ne spada u temu ovog lanka. 

http://hr.wiktionary.org/wiki/Suradnik:Bela
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USPOREDBA AV-FORMATA 
 

Video  Audio 
format medij Rezolucija 

(PAL)* codec 
Bitrate 
Mbps codec 

Bitrate 
kbps 

max. 
sati  

Kvali 
teta 

DVD 
Pla-
yer 

VCD CD 352x288 MPEG1 1,15 MP1 224 1,25 ~VHS ++ 

SVCD CD 480x576 MPEG2 ~2 MP1 ~224 0,5-1 ++ + 

DVD-video DVD 720x576 MPEG2 ~5 
MP1,MP2 
AC3,PCM ~448 1-2 

(loše>4) +++ +++ 

HDTV, HD-DVD HD-DVD 
HDTV 

1280x720 
(1920x1080) 

MPEG2, 
(H264/AVC) 

~20 
(~8) 

MP1,MP2 
AC3,PCM ~448 0,5 (-1) ++++ NE 

DivX, XviD .AVI ±640x480 MPEG4 ~1 
MP3,WMA i 

dr ~128 7-18 +++ + 
(novi) 

Quick Time MOV, QT ±640x480 MPEG4 i dr ~1 MP3  i dr. ~128 3-18 ++ NE 

RealMedia Internet* ±320x240 RM ~0,35 RM ~64 14-35 (++) NE 

DV mini-DV 720x576 DV 25 DV ~1500 20 min +++ NE 
 
Napomene: HD rezolucija 1920x1080 odnosi se na NTSC televizijski sistem (Europa koristi PAL) 
  VCD (Video CD) je zastario i više se prakti ki ne koristi iako ga playeri itaju. 
  HD sustav (ekstra kvalitetne reprodukcije) snima i reproducira samo HD oprema. 
  U grupu sa DivX  spada i WMV, ali ih ne itaju svi playeri. 
  Blje e otisnuto (osim VCD) "obi ni" DVD playeri ne itaju (NE u zadnjoj koloni). 
  ~ ozna ava ubi ajenu vrijednost, koja može biti i druga ija.  
  ± ozna ava tipi nu vrijednost rezolucije koja može biti i druga ija 
 
Sada je ve  sve jasnije.  Blje e otisnute formate zaboravimo ako je video sadržaj namijenjen za 
reprodukciju na DVD playeru. VCD zbog toga što je zastario, s ne baš kvalitetnom reprodukcijom, 
a ostale sa NE u zadnjoj koloni jer ih DVD-playeri ne itaju  (no, ako su odgovaraju i kodek-i 
instalirani, reproducirat e ih DVD pogon na ra unalu).  
 
Dobro je na ra unalu instalirati player (program za reproduciranje video sadržaja) koji ve  ima 
ugra ene važnije kodek-e, što e nas poštediti  brige oko pribavljanja kodek-a i problema s 
video-sadržajima koje naš ra unalni DVD pogon "ne želi pokrenuti". Takav besplatni player je 
primjerice VCL-media player  (Free Software Fundation. Inc – Boston) – www.videolan.org 
 
Ako nemamo opremu za video visoke definicije (Blu-Ray  tehnologija je uglavnom izgurala sa 
tržišta HD-DVD tehnologiju, dakle ako nemamo Blu-Ray player) ili ako želimo sami pržiti vlastite 
video snimke za player (tehnologije za takvo HD prženje za sada baš i nema na tržištu) možemo 
zaboraviti i na super kvalitetnu HD reprodukciju, u kojoj - i ako je imamo – za sada možemo 
gledati samo  naslove sa kupovnih Blu-ray diskova. No, to nas ne prije i da HD snimke gledamo 
na ra unalu sa Blu-Ray pogonom.  
 
Kona no, masno otisnuti formati, mogu se reproducirati na (mnogim) DVD-player-ima.  Op enito 
važi, da kvaliteta reprodukcije pada sa smanjenjem broja bitova potrošenih na jednu sekundu 
video reprodukcije (tzv. Video-bitrate). Jednako tako definira se i Audio-bitrate za zvu ni 
zapis. Izborom te vrijednosti  u Mbps (megabitima po sekundi) ili kbps,  možemo utjecati na 
kvalitetu zapisa, traže i kompromis izme u kvalitete i utrošenog vremena za rekodiranje – 
prženje, te memorijskog prostora 1. U specifikacijama playera navodi se koje formate, (odnosno 
video i audio kodek-e) podržavaju, maksimalne rezolucije, kao i podržani opseg  bitrate-a za 
pojedine formate zvu nog zapisa. Današnji player-i podržavaju audio-bitrate do nekih 320 kbps 
za MP3 i oko 4 Mbps za DivX. U svakom slu aju kod postave elemenata poštivat emo 
ograni enja koja je propisao proizvo  playera. Za MP3, uobi ajeni audio bitrate je 128 kbps. 

 
Logika name e slijede i izbor kodeka za (re)kodiranje video sadržaja: 

                                         
1 Ne treba miješati megabit (Mb) sa megabajtom (MB). Grubo se može uzeti da je MB osam puta ve i od 
Mb (barem u procesima sa osam bitnim bajtovima). 

http://www.videolan.org/
mailto:ipc@optinet.h
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Za HD reprodukciju putem ra unala (ali ne i na player-u):  format H.264  (zbog iznimne 
kvalitete reprodukcije), kodira se sa MP2 ili MP1 audio-kodek-om za kodiranje zvu nog 
zapisa (može se koristiti i AC3, PCM ili DTS). 

 
Za univerzalnu (vlastitu) uporabu (reprodukcija na ra unalu i na novijim DVD playerima)  
XviD ili DivX format možemo zakodirati video-kodekom MPEG4 i audio-kodek-om MP3 
(eventualno manje popularnim OGG, AAC, AC3), a možemo koristiti i WMV format. 

 
Diskove za razmjenu možda je bolje ispržiti u formatu DVD-video video kodek-om 
MPEG2 (radije nego sa MPEG1), i audio kodek-om MP2, ili MP1, jer bi za razliku od 
prethodnog formata DVD-video trebali  uredno reproducirati i stariji DVD-playeri. 

 
RealMedia s kodek-om RM je format slabašne rezolucije 320x240 piksela, pogodan jedino 
za razmjenu putem interneta (video streaming), pa emo ga jedino za to i koristiti. Za 
takvu namjenu može poslužiti i WMV, koji daje relativno dobru reprodukciju pri malim 
vrijednostima bit-rate-a, no  nažalost nije kompatibilan s mnogim vrstama playera, ima 
duže vrijeme otvaranja datoteka, neki programi ga ne mogu prebaciti u druge formate, 
automatski izbor ameri ke frekvencije osvježavanja od 30 slika/sek prilago en je 
ameri kom NTSC televizijskom sistemu, pa pri kodiranju treba aktivirati rekodiranje u 25 
sli ica/sek. koga koristi europski PAL sistem.    

 
 
No, rekli smo da iza capturinga (uzimanja sadržaja) s tipi ne digitalne video-kamere s mini-DV 
kasetom na ra unalo u pravilu dobivamo .AVI datoteku (vlasnici  HD video kamera još su ipak u 
manjini). Kameru doduše možemo i direktno priklju iti na iole suvremenije televizore, ali u tom 
slu aju gledat emo sve nepotrebne, loše snimljene, suviše duga ke itd. kadrove, odnosno 
nesre eni sirovi snimljeni materijal. Ako smo si dali truda da uredimo snimak na ra unalu (što 
nije tema ovog lanka), rezultat valja dobiti u nekom od navedenih preporu enih formata, zavisno 
o namjeni sadržaja. Naj eš e, htjet emo video iz vlastite pržilice gledati i preko DVD playera.  
 
Ve e sam program za  video-montažu (primjerice Pinnacle) uz "capturing", tj. uzimanje i 
automatsko sjeckanje sadržaja sa DV-kasete iz kamere na sekvence, uklju ivati pripremu 
"projekta" što rezultira "image-datotekom" koja se sprema na ra unalni disk. Uz izrezivanje, 
skra ivanje, spajanje, ubacivanje nekog efekata, program e omogu iti i ubacivanje fotografija, 
špica i predefiniranih menu-a u image-datoteku. Bolji programi omogu uju i korigiranje 
osvijetljenosti, kontrasta i dr, te manipulaciju sa zvu nim zapisom. Image datoteka, služi za 
pripremu automatskog kodiranja budu eg (naj eš e DVD-videa, što nam naj eš e i treba) s 
upisom na ra unalni disk, ili prženjem direktno na opti ki medij. Tzv. "Instant" programi koji su 
najjednostavniji za korištenje (ima ga i spomenuti Pinnacle),  rade gotovo potpuno automatski s 
pretpostavljenim parametrima i malo toga se na njima može birati i podešavati, pa naj eš e ipak 
daju korektan rezultat.  Tko želi više kontrole, mora pribje i nešto složenijoj manuelnoj obradi ili 
softveru, poput besplatnog VirtualDubMod-a.  
 
Kona no, tu je i slu aj kada iz bilo kog razloga trebamo rekodirati postoje i video s ra unala ili 
drugog medija 2 , tj. izvršiti pretvorbu iz postoje eg formata u neki drugi . Taj e posao nakon 
postave parametara automatski sasvim pristojno obaviti i besplatni  Any video Coder ili 
MediaCoder sa ve  ugra enom paletom formata i kodek-a, što e nam uvelike olakšati život. Što 
ete upisati u postave, za po etak zaklju ite iz ovog prikaza i prethodne tabele, vode i ra una o 

podržanim kodekima, opsezima i bit-rate-ima iz uputa uz Vaš DVD player, a ostalo ete nau iti 
pokušavanjem i konzultiranjem nešto naprednije literature od ovog "šalabaktera za po etnike". 
Rekodiranje je zgodno zapo eti prije ve ere ili ve ernjeg filma, pa dok se Vi regenerirate,  
Mediacoder e raditi, ako nemate namjeru nepotrebno stražariti pored ra unala dok je Vaš 
procesor pod 100 postotnim optere enjem. Vrijeme obrade zavisit e od odabrane kvalitete videa, 
primijenjenog programa za obradu, ali i od performansi Vašeg hardvera, no rije  je o satima. 

                                         
2 Želimo li mijenjati format video zapisa sa postoje eg opti kog diska i njega valja prebaciti na ra unalni 
disk (nekim programom poput DVD Decrypter-a), jer zaštita od kopiranja na kupovnom DVD-u sprje ava 
konverziju iz jednog u drugi format. Vodite ra una o autorskim pravima ! 

mailto:ipc@optinet.h
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Kopiranje ili izrada slike ("Image-datoteke") sa DVD-uzorka 
(jednostavan na in za kopiranje filmova-a vidi ovdje ) 

 
Izrada, da ne kažemo "prženje" video diska namjena je programa Imgburn. Odmah razjasnimo 
da ImgBurn "ne zna" rekodirati, tj. kopija e imati format jednak uzorku. Ako bi trebalo 
mijenjati format videa, prije ImgBurn-a trebat ete se poslužiti nekim programom za 
rekodiranje (besplatni su  MediaCoder i Any Video Coder) kako je opisano u primjeru 3. Sa 
iznimno jednostavnim za uporabu Any Video Converter-om lako e video rekodirati i po etnici. 
Postavlja se pitanje, emu uop e kopirati DVD ako ga ve  imamo ?  Prva je namjena dakako 
izrada pri uvne kopije. Osim ošte enja sadržaja zbog este (nepažljive) uporabe, doga a se i da 
neki player ili DVD pogon "sažva e" disk, tj. snabdije ga dubokim ogrebotinama. Pokazalo se uz 
to, da trajnost zapisa na opti kim medijima i nije baš toliko velika kako se mislilo po etkom 
njihovog razvoja. Stoga vrijedne sadržaje valja popvremeno presnimiti na novi medij, prije nego 
postanu ne itljivi.  Na kraju, ImgBurn može snimiti i sadržaj sa ra unalnog na opti ki disk, dakle 
može se koristiti i za izradu pri uvnih kopija ili arhiviranje važnih sadržaja koje ina e držimo na 
ra unalnom disku.  
 
Iako je obi no kopiranje (nezašti enih CD-a) na jednostavan na in mogu e izvesti i u samim 
windowsima (od verzije XP na dalje) a DVD-a bilokojim programom za tzv. "instant" kopiranje, 
esto pri tome nastaje previše artefakata (neispravnih piksela u sli icama kadra) i grešaka,  pa 

je bolje to izvesti uz pomo  npr. programa ImgBurn. Postupak je najjednostavniji za prženje 
gotovog video-sadržaja sa ra unalnog diska na prazan opti ki disk, a nešto složeniji ako se 
izvornik nalazi na postoje em opti kom disku. Kopiranje s diska na disk može se obaviti i kad 
imamo samo jedan opti ki pogon. U tom slu aju naime prije prženja sadržaj treba sa 
(nezašti enog) izvornog opti kog diska kopirati ili "preslikati" na ra unalni disk, opcijom glavnog 
menu-a  Mode > Read  (Na in rada > itaj).  Starije i novije verzije ImgBurna se nešto 
razlikuju, ali ovdje opisane komande uvijek e inicirati isti postupak. 
 
Slijedi zapisivanje, ili kako je u izvorniku to nazvano  Build (Ugradnja) sadržaja na opti ki disk. 
Pamtimo, da opcija Write (zapis) služi za zapisivanje tzv. "slike"  ili  image-datoteke, tj. zapisa 
koji nije direktno itljiv na DVD-pogonu ili playeru, dok sadržaj u obliku koji se može 
reproducirati daje opcija Build.  U zagradama su navedeni nazivi komandi u hrvatskoj verziji. 
 
Na kraju, ImgBurn može ispržiti i video disk koriste i postoje u kompatibilnu img.datoteku (koja 
je možda izra ena u nekom programu za editiranje videa), a može dakako i snimiti takvu  img-
datoteku sa postoje eg video-diska. Ona može imati nastavak .img ili .ISO.  
 
Nadalje, pamtimo da opcija  Output > Device  (Izlaz > Ure aj)  zapisuje sadržaj na opti ki 
disk, dok Output > Image File  (Izlaz > Image-datoteka) naravno snima  .img datoteku. Na 

dnu su elja su svije sli ice, a 
lijevo od njih je i mala 
ikonica. Kad je desna sli ica 
samo krug, izlaz e biti 
"normalni" video sadržaj, a 
ako je desno krug u 
pravokutniku, bit e 
snimljena  img. datoteka. Da 
li e ona biti snimljena na 
ra unalni ili na opti ki disk, 
možemo odrediti klikom na 
malu ikonicu lijevo od 
spomenutih dviju sli ica. 
 
U trenutno najnovijoj verziji  
2.4.2.0  opcija  EZ Mode 
picker . . . (hrvatski preve-
deno kao "Glavni izbornik") 
nudi izbor operacija po slici. 

No, isti se postupci mogu inicirati i direktnim izborom gore navedenih opcija iz naredbene trake. 

opcije za snimanje 
.img-datoteke 

opcije za kopiranje 
sadržaja 

http://inovatori.hr/Kopiranje_filmova_s_5_klikova_Jednostavnije_ne_moze_%21.pdf
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Na kraju, spomenimo da sa zašti enih diskova kopiju, odnosno .img-datoteku mogu snimiti 
samo neki programi poput DVD decrypter-a.  Vodite ra una o autorskim pravima !  
 
Prikažimo sažeto konkretno itav postupak:  Prženje sadržaja s ra unalnog diska je 
najjednostavnija operacija u programu ImgBurn: 
 

Na lijevoj strani su elja treba unijeti lokaciju uzorka, koriste i ikonice koje otvaraju 
interni pretraživa   

 
Iz naredbene trake na vrhu su elja treba izabrati naredbe  Mode > Build  (Na in rada > 
Ugradi). U desnom dijelu su elja prikazat e se kalkulator koji pokazuje potrebnu vrstu i 
predvi eno zauze e opti kog diska. Uz to biramo Output > Device  (Izlaz > Ure aj)  
što nalaže programu da  sadržaj  upiše na opti ki disk. Ako bismo mjesto toga koristili 
opciju  Output > Image File  (Izlaz > Image-datoteka), rezultat bi bio  .img – snimak 
(tzv. "slika"), a ne u playeru ili DVD pogonu itljiv video sadržaj. 

 
U eliji Destination (Odredište) biramo DVD-pogon koji emo koristiti za prženje, ako 
imamo više od jednog pogona (ili folder u koji e se upisati .img-datoteka, ako smo 
odabrali opciju izrade "slike") Na odredištu moramo imati cca 5GB praznog prostora.  

 
U Settings-u (Postave) biramo brzinu upisivanja na disk. Želimo li sigurno itljiv DVD i 
na jogunastijim DVD pogonima, preporu aju se niže brzine pisanja, ili ak najniža (1 x). 
U postavama možemo tako er uklju iti automatsko finaliziranje DVD-a iza prženja). 

 
Test Mode (Ispitni na in rada) "glumi" prženje, pa ne emo izgubiti prazan medij ako 
nešto krene po zlu, ali e postupak trajati dvostruko duže. Kva ica na Verify (provjeri) 
provjerava ispravnost upisa i tako er produžuje trajanje operacije. 

 
Klik na sli ice na dnu panela lijevo pokre e postupak upisa sadržaja na disk. Ova 
komanda je neaktivna (zamagljena) ako nije umetnut prazan  ili RW medij u opti ki 
pogon. Ako je u pogonu  ispisan RW medij, program e tražiti dozvolu za brisanje 
postoje eg sadržaja, te upis po eti nakon toga brisanja. Tijek postupka vidljiv je na bar-
grafu koji e napredovanje postupka prikazati i u minutama i procentualno.  

 
Ne prekidajte postupak kada indikator prikaže 100 % izvršenja, nego se strpite dok se 
obavi finaliziranje diska, tj, dok mali okviri  ne obavijesti (i zasvira ako je zvuk uklju en na PC-
u) o završetku procesa  
 
ImgBurn  na svojoj web-stranici (http://www.imgburn.com/index.php?act=download) nudi i 
zakrpu za hrvatski jezik u obliku zip-faila croatian.zip, koju iza skidanja sa interneta treba 
raspakirati u subfolder Languages  foldera  IMGBURN na lokaciji na kojoj je ovaj instaliran. 
Hrvatski jezik (samo komande, ali ne i HELP) aktivira se u menu-opciji Tools > Settings pod 
Language. Mijenjanje brojnih drugih defaultnih postava, za osnovnu uporabu nije potrebno. 
 
Postupak je sli an i kod kopiranja ili izrade .img-datoteke sa uzorka na opti kom disku, samo 
tada prije prženja sadržaj s diska treba prebaciti na ra unalo kako slijedi: 
 

Uzorak umetnemo u DVD pogon i aktiviramo ImgBurn. Na PC-u s više DVD pogona u 
polju source (izvor) provjerimo da li je ispravno upisan DVD pogon u kome se nalazi 
uzorak koji želimo kopirati i po potrebi korigirajmo lokaciju izvorišta. 
Iz menu-a na vrhu su elja biramo Mode (Na in rada)  > Read  ( itaj).  Lokaciju na koju 
emo spremati sadržaj definiramo u desnom dijelu su elja (Default Destination) u eliji s 

ikonicom koja otvara interni pretraživa .  Klik na OK pokre e postupak itanja uzorka.  
Tako stvoren sadržaj, koristimo kao Source  (Uzorak) u ve  opisanom postupku prženja.   

 
Umjesto toga, isti sadržaj možemo koristiti i za izradu  .img-datoteke biraju i  Mode > Write 
(Na in rada > zapis).  Lokacija .img-datoteke se definira naredbama:  Tools > Settings > File 
Locatins > Image Files  (Alati > Postave > odredišne datoteke > Image–datoteke).  

http://www.imgburn.com/
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Izrada image-datoteke   Primjer 1 
 
Za pirmjer, navodimo pretvorbu na DVD-playeru "ne itljivog" videa, krcatog brojnim datotekama 
s nastavcima  .BUP, .IFO  i  .VOB, uz koje na po etku stoje i failovi VIDEO_TS.BUP, 
VIDEO_TS.IFO i  VIDEO_TS.VOB.  Na ra unalu menui nisu funkcionirali (vjerovatno zbog nekog 
nedostaju eg kodeka), ali direktnim pokretanjem ve ih datoteka  .VOB (nešto preko megabajta 
svaka) video e se reproducirati na ra unalu s urednom reprodukcijom zvuka. Nakon instaliranja 
VLC-media player-a, proradili su i menui, tj. video se sasvim uredno reproducirao na ra unalnom 
DVD-pogonu. No, na DVD-playeru ništa od reprodukcije.  Video je o ito kodiran u formatu koga 
DVD-player ne podržava. Za takav slu aj, primijenjen je slijede i postupak: 
 

Problemati ni video-uzorak umetnut je u ra unalni DVD-pogon, pokrenut je besplatni 
program ImgBurn. Aktivirao se glavni panel  ImgBurn-a. 

 
 U meni-u biramo  Mode > Build, jer želimo izgraditi "image-datoteku". U prikazanom 
panelu desno pod Options stavljamo kva icu na ISO9660 jer po uputama naš  
DVD-player podržava opti ke diskove samo u tom formatu, pa definiramo sadržaj foldera 
VIDEO_TS našeg DVD-uzorka kao Source (izabrali smo sve njegove datoteke).  

 
U meni-u kliknemo na Output i kao oblik izlaza biramo Image File koji time dobiva 
kva icu, pa za  Destination (odredište), biramo folder u koji e se naseliti gotova image-
datoteka (prethodno pripremljen prazan folder nazvali smo "image"). Image-datoteci treba 
dati i ime. 

 
U menu-u Tools (alati)  pod Settings (postave) možemo ostaviti sve defaultne 
(preddefinirane) postave, pa tako ostavljamo i kva icu na opciji Don't Update IFO/BUP 
Files (isklju uje se ažuriranje datoteka s navedenim nastavcima). 

 
Još uvijek u Toos > Settings u podmenu-opciji Build tako er ostavljamo sve predefinirane 
postave, me u kojima i Volume Label – Auto "Yes" pa e program sam izmisliti oznaku 
medija na koga emo napržiti naš video ako ga mi ne zadamo (ta nam oznaka ni po emu 
nije bitna). 

 
Za svaki slu aj pregledali smo i ostavili i sve ostale na preddefinirane opcije. OK i klik na 
sli ice za pokretanje procesa pokre e potpuno automatsku izradu image-datoteke. 
Program nas još pita želimo li u glavnom folderu image-datoteke vidjeti samo folder 
VIDEO_TS ili i sve njegove datoteke. Biramo ono prvo, tj. YES. Slijedi pitanje da li se 
slažemo sa automatski predloženim nazivom kreiranog volumena, tj. oznakom gotovog 
DVD-a koji je potpuno nebitan (odgovor je YES). Na kraju procesa koji na boljem ra unalu 
traje 7-8 minuta, možemo provjeriti da li je nova image-datoteka stvarno na odredištu.  

 
Slijedi prženje. U menu opciji Mode ovaj puta biramo Write (piši) i kao Source pod 
Please select a file biramo u priru nom pretraživa u upravo kreiranu image-datoteku 
kao uzorak, a kao odredište (Destination) možemo odabrati neku lokaciju na fiksnom 
disku ili prazan DVD kojim smo u me uvremenu zamijenili "nevaljati" uzorak. Sporiji upis 
(Write Speed = 1x) bi trebao garantirati bolju itljivost  DVD-a. U Tools > Settings pod 
Write Ostavljamo  preddefinirani DAO na in upisa (Write Type) umjesto "incremental". 
Tako er ostavljamo preddefiniranu kva icu na opcijama DVD+R Finalise Disc, tj. 
uklju ujemo automatsku finalizaciju jer DVD-player ne e itati nezaklju ene medije. 
Možemo ostaviti i  Enable BURN-Proof ime se doduše produžuje proces, ako ne želimo 
riskirati gubitak praznog medija u slu aju da proces upisivanja naleti na kakav problem. 
Klik na OK i sli icu za pokretanje prženja pokre e automatsko prženje. Iza ve ere 
provjeravamo što je rezultat svega re enoga i na odredištu vidimo samo dva foldera i to 
prazan AUDIO_TS i  VIDEO_TS  u kome je opet hrpa .BUP,  .IFO  i  VOB  datoteka sa 
VIDEO_TS.BUP,  VIDEO_TS.IFO i VIDEO_TS.VOB na elu kao i na "nevaljatom" disku, 
samo ovaj puta DVD-player veselo vrti sve što treba, uklju ivo menu-e i zvu nu pratnju, 
sa kvalitetom reprodukcije "za prste polizati". Nakon malo prakse, mo i emo po želji 
isklju iti i eventualne suvišne sadržaje (reklamne spotove i sli no) ako ih u originalu ima.  
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Primjer 2:  Presnimavanje  Dvoslojnog (Dual Layer) izvornika na jednoslojni medij 
 
Dvoslojni mediji imaju dva aktivna sloja jedan ispod drugoga, na koje je posebnom 
tehnologijom dvoslojnog snimanja mogu e na DVD snimiti sadržaj u dva sloja, tj. takav medij 
(u oznaci ima DL) ima približno dvostruki kapacitet u odnosu na obi ni, jednoslojni medij. 
Dakako, sadržaj dvoslojnog medija može strpati na "obi ni" DVD samo ako se rekodira, 
primjerice u MPEG format iz primjera 3. U tom formatu sadržaj e stati na jedan jednoslojni 
medij a nakon prženja na DVD bit e normalno itljiv i na DVD Playeru. Drugi na in bio bi, da se 
sadržaj podijeli na dvije cjeline, pa se svaka cjelina zasebno isprži na dva jednoslojna DVD-a. 
 
Kako je ve  re eno, sadržaj prije daljnje obrade treba prebaciti sa DVD-a na ra unalo, npr. 
programom  DVD Decrypter. Prilikom prebacivanja izvornika na PC, mogu e su dvije opcije: 
Prebacivanje itavog sadržaja (opcija Full Disc) ili samo glavnih sadržaja (Main Movie). Druga 
opcija e uštediti nešto memorijskog prostora. Ako se odabere druga opcija, u postavama je 
mogu e definirati koji e se jezici i koji titlovi sa višejezi nog audiozapisa prenijeti na disk. 
Koristimo li ovu opciju, bit e naime izostavljeni ugra eni menui (ako postoje) u kojima se bira 
jezik. 
Ako u postavama DVD Decrypter-a odaberemo hrvatski jezik i opciju bez titlova,  reprodukcija 
bilo kojeg VOB faila ili rekodiranog MPG faila automatski e krenuti na hrvatskom jeziku, što  
zna ajno pojednostavljuje rukovanje. Ako sadržaj ne rekodiramo, pametniji playeri me utim 
nedostatak failova sa menuima mogu shvatiti kao ilegalnu kopiju i odbiti reprodukciju kopija 
zašti enih programa, odnosno automatski e stopirati reprodukciju koja se ina e na PC-u može 
normalno odvrtiti. Zbog toga je bolje rekodirati sadržaj preba en na PC opcijom "Main Movie".  
 
Ako se ipak odlu imo na rješenje bez rekodiranja, izvorni sadržaj e zauzeti više od jednog 
jednoslojnog DVD-a. Izvornici esto imaju više epizoda. esto e prijelaz iz jedne epizoda u 
drugu biti negdje na sredini nekog od  .VOB failova, pa ako se dijeljenje u dvije cjeline vrši 
izborom .VOB failova, rerodukcija sa prvog presnimljenog DVD-a e završiti negdje u sred 
epizode. To nije baš zgodno, pa u tom slu aju .VOB datoteku na kojoj je prijelaz tako er treba 
podijeliti na mjestu prijelaza iz jedne u drugu epizodu, nekim programom za dijeljenje velikih 
failova kao što je  Gsplit2.  Prvi dio datoteke priklju it e se .VOB failovima prve cjeline, a 
drugi dio uz drugu cjelinu.  
U programu za dijeljenje datoteke (Gsplit2) za prvu parcijalnu cjelinu treba zadati veli inu u 
bajtima, a druga cjelina e sadržavati ostatak. Možda e trebati malo eksperimentirati, jer je 
dosta teško "pogoditi" od prve mjesto prelaska s jedne epizode na drugu na temelju vremena 
koje se u minutama iskazuje prilikom reprodukcije. Sre om dijeljenje ne traje dugo, pa ga nije 
problem u slu aju potrebe ponoviti (u desnom panelu Gsplit-a samo brišite prijašnje parcijalne 
cjeline i inicrajte postupak ponovo). 
 
Tako raspolovljene cjeline vjerojatno emo mo i uredno reproducirati na ra unalu (nekim 
programom poput besplatnog VLC media player-a, koji u sebi ve  sadrži mnoštvo potrebnih 
kodek-a). No, sadržaj možemo postupkom iz prvog primjera (Build + Write) napržiti i na dva 
obi na DVD-a programom ImgBurn.  Nije me utim garantirano da e player htjeti reproducirati 
ove kopije, posebno ako je korištena opcija "Main Movie"  DVD Decryptera. 
 
S druge strane, koristimo li opciju "Full Disc", mogu se javiti jezi ni problemi u drugoj 
parcijalnoj kopiji, tj. nemogu nost izbora jezika na drugoj cjelini (drugim rije ima, sadržaj e se 
reproducirati na izvornom ili engleskom jeziku bez mogu nosti promjene). Na meni-u prvog 
DVD-u pak ne treba birati one sekvence kojie nisu stale na disk, jer e to zbuniti i blokirati 
player, pa emo ga morati ugasiti i ponovo pokrenuti. 
 
Kad se sve zbroji, iza prebacivanja dvoslojnog medija na ra unalo, na njemu e se sadržaj mo i 
uredno reproducirati, ali s reprodukcijom na playeru mogu se javiti problemi. Uredno se može 
reproducirati dio sadržaja s menuima koji staje na jedan jednoslojni medij, ali mogu nost 
reproduciranja ostatka je upitna, ili je barem upitna mogu nost reproduciranja stranih izvornika 
na hrvatskom jeziku.  Primjena opcije "Main Movie" koja bi riješila pitanje jezika, može opet biti 
razlogom da Player odbije reproducirati sadržaj, tj. reprodukcija na TV-ekranu e se automatski 
stopirati bez mogu nosti pokretanja. Stoga je bolje rekodirati sadržaj u MPEG format. 
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Primjer 3 – rekodiranje         (Alat za jednostavno_rekodiranje   vidi na kraju lanka) 
 

AVI datoteku – rezultat capturing-a iz DV kamere želimo rekodirati u MPEG video radi prikaza 
na DVD-playeru (postupak se može primijeniti i na VOB datoteke primjerice zbog smjreštaja 
dvoslojnog izvornika na jedan jednoslojni DVD disk). ImgBurn "ne zna" rekodirati, pa zato: 
 

Otvaramo MediaCoder i iz izvornika Glavni panel MediaCodera sadrži prostor za popis   
biramo AVI (ili VOB) failove failova koje emo rekodirati, u koga failove  

 (prethodno uklonimo prijašnji ubacujemo komandom Add file ili  Add Dir ili 
     popis menu-komandom Remove) Add Track za grupno ubacivanje failova. 
 
Media Coder nudi tri izgleda su elja (radnog panela) zavisno o iskustvu korisnika, koji se biraju 
pod menu opcijom Action >  User Interface Mode :  Simple Mode, Normal Mode i Expert 
Mode.  Opis u nastavku odnosi se na  Normal Mode. 
 

U Output Folder-u definiramo odredište   (klik na tri to kice otvara interni pretraživa ) 
 

Lijevo dolje pod Audio biramo Lame MP3  desni klik na Options omogu uje postavu  
Audio-bitrate-a (limitira je uputa uz DVD player) 
Postavimo kliza  i klik na Ok. 
  

Lijevo kliza  Quality stavljamo na maksimum, Rate mode: 2-Pass (dvoprolazno), a pod 
Container  biramo MPEG, pod dugmetom Option > MPEG Options – Format biramo PAL 
DVD u polju Value .  Dvoprolazno rekodiranje osigurava najbolji kvalitet reprodukcije uz 
raspoloživi diskovnio prostor, tj. optimalno iskorištenje memorijskog prostora.   

 
Desno usmjerenim trokuti em idemo do jezi ca Preview i biramo Converted, pa e se 
prilikom procesa prikazati konvertirani video 

 
U Action iz glavnog menu-a biramo Start Transcoding i time zapo inje automatski proces 
prekodiranja jednog po jednog AVI faila sa liste u dva prolaza. Na samom dnu panela vidi 
se koja faza rada je u tijeku, a tijek procesa prate grafikoni u sredini panela. Prvi prolazi 
rekodiranja rezultirat e iskazom greške u svim failovima sa liste, ali ne prekidajte proces, 
drugi prolaz je tek stvarno rekodiranje, koje može trajati više sati. Brzina obrade bit e 
približno 1 MB/sek na boljem ra unalu, ako rekodiramo na vrsti disk, pa se treba oboružati 
strpljenjem (na sre u za vrijeme postupka možemo raditi nešto drugo na ra unalu). 
Rezultat e biti fail s nastavkom .MPG, i do 4 puta manjih memorijskih potreba od izvornika 

 
Ako je rezultat usmjeren na vrsti disk, ne bismo preporu ili kopirati ga na opti ki disk 
"obi nim" instant – kopiranjem koje omogu uju neki programi za prženje, jer bi kopija mogla 
biti slaba, s puno artefakata (bijelih piksela u kadrovima), ili bi mogla zapinjati i "zamrzavati se" 
pri reprodukciji, nego je bolje za to koristiti postupak Build – Write iz primjera 1 pomo u 
programa ImageBurn. 

 
NAPOMENA:  
Treba primijetiti, da se prilikom prekodiranja videa snimljenog za reprodukciju preko DVD 
player-a u video za prikaz na ra unalnom monitoru javlja i potreba za prilagodbom rezolucije. 
Budu i da piksel na televizijskoj slici nije kvadrati an kao na ra unalnom monitoru, ve  
pravokutan, s nejednakim stranicama, to bi se geometrija slike promijenila kad bi rezolucija 
ostala nepromijenjena ili ako bi se proporcionalno promijenila. Konkretno, DVD format (ako nije 
HD) u Europskom PAL sustavu ima rezoluciju 720x576 piksela, dok je rezolucija ra unalnog 
monitora  s odnosom stranioca 4:3  768 x 576.  Za izra unavanje ispravne rezolucije u 
konkretnim slu ajevima služe programske rutine – kalkulatori, koji unosom ulaznih parametara 
nude set ispravnih rezolucija, koje treba primijeniti prilikom rekodiranja. Takav je kalkulator 
primjerice  Aspect 2.1.0. 
Suvremeni LCD televizori nas rješavaju brige oko odnosa stranica za "obi ni" ili široki ekran 
(4:3 ili 16:9), budu i da omogu uju biranje tog odnosa na samom televizoru.  
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OSNOVNO KORIŠTENJE VirtualDubMod – a 
 
 
Na ra unalu trebaju biti instalirani kodeki  s kojima namjeravamo raditi. Na i ih možemo na 
internetu, a skinuti treba  "binarny" a ne samo izvorni kod. U pravilu e imati i instalacijski 
program, a ako je skinut u ZIP-failu, u njemu e biti i datoteka s nastavkom  .INF.  Iza 
otvaranja ZIP-arhive desni klik na datoteku *.INF  pokrenut e instalaciju. Ne treba prekrcavati 
ra unalo sa svim mogu im kodekima, jer pojedini kodeki mogu izazivati i probleme. Uzimajmo 
samo one koji nam trebaju. Shodno tome, veliki "paketi" sa hrpama kodeka i još koje ega ne 
moraju biti dobro rješenje. 
 
Razlikujemo slabiju kompresiju bez gubitka kvalitete (lossless) i kompresiju koja manje ili više 
kvari kvalitet (lossy), ali je stupanj kompresije koga ona postiže ve i. Kod  lossy kodeka, koji 
se eš e primjenjuju, esto se pribjegava tzv. dvoprolaznom kodiranju koje omogu uje 
promjenjivu vrijednost bitrate-a. Prvi prolaz služi za odre ivanje mogu e kompresije pojedinih 
slika, a samo kodiranje se izvodi u drugom prolazu. Time se postiže optimalno iskorištenje 
raspoloživog memorijskog prostora, tj. najbolji mogu i kvalitet reprodukcije uz raspoloživi 
diskovni prostor. 
 
 
Po aktiviranju  programa VirtualDubMode  otvaramo (jednu po jednu) datoteku sa uzorka videa 
koga želimo rekodirati komandama 
 
File > Open  

Priprema zvuka 
 
Streams > Stream List > desni klik na zvu nu komponentu, ako je treba rekodirati. 
 
Full Processing Mode > Compression  biramo kodek (koga oprema –npr. player- podržava) 
 Za MP3 e to biti "Lame". Biramo i kvalitet kodiranja. 
 
 

Priprema videa 
 
Video > Full Processing Mode > Compression    i biramo kodek 
 
Configure konfiguriramo kodek, uvažavaju i zahtjeve opreme 
 
Po potrebi  korigiramo i oblikovne karakteristike slike (dimenzije, kontrast i dr.), tj.  klikom na:  
 
Filters   dodajemo i podešavamo željene filtre. 

Kodiranje 
 
File > Save As         Ako emo dvoprolazno kodirati onda e Dont run this job now umjesto 
kodiranja samo upisati kodiranje u listu zadataka. Isto ponavljamo sa drugim prolazom. 
 
Job Control > Start  pokre e proces kodiranja. 
 
Rezultat kodiranja je  .AVI datoteka na odabranom odredištu, koju programom ImgBurn možemo 
napržiti na prazan DVD na na in iz prethodnog primjera. 
 

……………………………………………………. 
 
Još jednom upozoravamo, da je u slu aju zašti enih izvornika dopustivo kopirati samo pri uvnu 
kopiju, dok je svako drugo umnožavanje protuzakonito. 
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JEDNOSTAVAN NA IN ZA REKODIRANJE  
 
Video u visokoj kvaliteti koga uvate na disku ili DVD-u, želite podijeliti s publikom na društvenoj 
mreži, dakle morate ga rekodirati u neki prikladniji format za upload primjerice na Twitter – 
recimo u flash (datoteku s nastavkom .FLV) dakako uz razumljivi gubitak kvalitete, što mali 
formati na mreži mogu podnijeti. 
 
Zadatak je najlakše obaviti uporabom ve  spomenutog besplatnog  Any Video Converter -a ija 
se uporaba svodi na kopiranje izvorne video datoteke u središnji prostor uvodnog (ujedno 
jedinog) panela konvertera na slici i izbor željenog izlaznog formata na desnom dijelu panela. Any 
Video Converter omogu uje konvertiranje videa proizvoljnog formata u naj eš e korištene 
formate, me u kojima i one za  suvremene mobilne telefone i tablete, kao i u .flv flash-format 
prikladan za razmjenu putem interneta i društvenih mreža. 
 

 
 
Kako Twitter ne nudi opciju za direktan upload videa kao YouTube, prijenos konvertiranog videa 
na Twitter treba obaviti npr. na web-sjedištu  www.Twitvid.com  (vidi našu uputu na:  
upload_videa_na_twitter.pdf ) 
 
Tako er spomenimo i da postoje konverteri koji omogu uju potpuno automatsko ekstraktiranje 
zvu nog zapisa  direktno iz video datoteka, pa i direktno sa YouTube-a, dakle izvla enje MP3 
datoteke direktno sa društvene mreže. Takav je primjerice  Free video to mp3 converter, 
zatim programi koji u video datoteku snimaju ono što se doga a na ekranu (besplatni TipCam ili 
kvalitetniji, ali ne i besplatan BB FlashBack_recorder . 
Video sa YouTube mreže možete skinuti na ra unalo programom  Free_YouTube_Download . 
 
Tako er postoje konverteri za pretvorbu Powerpoint prezentacija u video (budu i neke stranice ne 
prihva aju upload Powerpoint prezentacija), npr.   E.M._Free_PowerPoint_Video_Converter  
Sve u svemu, za svaki zadatak koji se može pojaviti u radu s videom sigurno postoji prikladno, 
možda ak i besplatno rješenje, samo treba malo potražiti po Internetu. 
 

 
Popularne teme – iPC – Rijeka 

http://www.any-video-converter.com/products/for_video_free/
http://www.twitvid.com/
http://inovatori.hr/upload_videa_na_twitter.pdf
http://www.dvdvideosoft.com/
http://www.bbsoftware.co.uk/
http://dvdvideosoft.com/guides/Free-YouTube-Download.htm
http://www.effectmatrix.com/PowerPoint-Video-Converter/index.htm
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